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Overview

Scope Inputs

The digital storage scope Hantek6022BE (as well as the similar Hantek 6022BL) allows to
measure two voltage channels CH1 (yellow) and CH2 (blue).

The input impedance is 1 MQ | | 25 pF (a typical value for scope inputs).

The measurable input signal range is +5 V.

Each input section contains an 8-bit ADC (analog to digital converter) that allows to sample
the input voltage at a chosen sampling rate (10 kS/s ... 30 MS/s) and to transfer the digital
value to the PC via USB where it will be processed and displayed.

Voltage Limits

Input voltages outside the safe range of + 35V can lead to permanent damage!

Calibration Output

The calibration output (blue, right side) delivers a square wave 0 V/ 2V @ 1 kHz that can be
used to adjust the frequency compensation of 10X probes.

The frequency can be varied between 32 Hz and 100 kHz to deliver a versatile test signal.

USB Connection

The Hantek6022 uses USB 2.0 high-speed transfer. It is preferably connected directly to the
PC, without a USB hub in between. Make sure that the device does not share its high-speed
bus with other devices, this can be checked with the Linux commands 1lsusb; lsusb -t.

If you encounter problems using a USB3 port on your computer, you should switch to a USB2
port or interpose a USB2 hub.

The device is powered over USB with a typical current consumption of less than 500 mA, so a
good quality USB 2.0 cable is sufficient, no need to use the strange red/black Y-cable.

OpenHantek6022
The program OpenHantek6022 allows the usage of the scope under the Linux operating
system. The development and test platform is Debian stable.

OpenHantek6022 requires a recent Linux system with libusb-1.0, libfftw3 and the Qt libraries.
It compiles also under RPi, FreeBSD, MacOS and Windows, but these systems are untested.

Fork me on GitHub! https://qithub.com/OpenHantek/OpenHantek6022

This document describes program version 3.4 - subject to change without notice.
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Starting OpenHantek6022

The executable program is named OpenHantek.
It is installed (under Linux) in the directory
/usx/bin, so it can be called directly from a

Select device

Devices: DD5120 DEMO D50-6022BE DS0-6022BL DS0-2020

term i nal Or Via the men u entry openHantEk. OpenHantek6022 is searching for compatible devices ...
Don't forget to switch your device into oscilloscope mode if it has
multiple modes.

Th e h a rdWa re Of H a nte k DSO 6022 CO nta | n a Please make sure you have copied the udev rules file to
Jusr/lib/udev/rules.d/60-hantek.rules or

Cyp ress EzUSB processor that controls the data gztrc’:ll:;;r::uIes.dlﬁo—hantek.rules for correct USB access

sampling and the USB transfer. The device does s i o o o ek o s

not contain a flash, the firmware must be loaded
into the RAM at the 15t program start after =

powering the device. The uploaded firmware is e ‘ s
lost after switching off the scope or disconnecting
the USB, so the device can never be bricked.

Even without a device you can explore the program's function.

After starting the program, it searches for a
supported device by checking the USB VID/PID
of all connected USB devices.

DS0-6022BE: VID 0x04B4 PID 0x6022 e =
DSO-6022BL: VID 0x04B4 PID 0x602A Upload in progress..

DS0O-2020: VID 0x04B4 PID 0x2020 e vl o el e e
DDS120: VID 0x8102 PID 0x8102

If only one scope is found, the firmware will be
uploaded automatically. In case of more devices
the user can select from the list of devices.
After the upload the VID changes to 0x04B5.
The PID of the DSO-6022BE/BL doesn't change. Bilfe © schiieten
The DS0O-2020 changes its PID to 0x6022 and
the DDS120 changes its PID to 0x0120.

If the firmware is uploaded successfully, the LED left of the CH1 connector blinks red.

Select device

Supported device | Try unsupported

Devices: DSO-6022BE D50-6022BL

If the upload takes more than 30 s, please

close the window and restart the program. , Select device

This can happen in rare cases when another high supported devce IR L

Speed USB device blocks the same USB bus. Devices: DSO-6022BE DSO-6022BL

If this happens, use another USB port of the i -

Device ready to use

computer or disconnect the other device.

The oscilloscope shall be connected to an HS-
USB bus alone so that it works undisturbed
and also does not interfere with other devices.
Under Linux you can check this with:

Isusb; 1lsusb -t

i Hilfe « OK @ SchlieBen

If the device is ready to use, the scope program starts automatically.

Follow the Quick Start Guide to get a feeling for the program or start your real measuring job.
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Other Operating Systems

FreeBSD

MacOS

Raspberry Pi

Windows
MINGW

This is the preferred Windows build. Only the file OpenHantek6022 . exe is needed. It uses
libusb to access the USB. The necessary driver is located in the folder driver, right-click on the
openhantek.inf and chose install.

MSvC

It uses libusb to access the USB. The necessary driver is located in the folder driver, right-click on
the openhantek. inf and chose install.
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Demo Mode

You can explore the look and feel of the program even without having the scope hardware
available, just click the Demo Mode button on the Select device window
or start the program as: OpenHantek --demoMode

OpenHantek6022 (3.2.4) - Demo Mode

File Expot View Oscilloscope  Help

1 ms/div [RIETENE

CH1 |2V v
[Jmvet | xt  7|/DC v

CHz |2V v
[Jwvet | x1 7|/DC v
(] maTH | 2V v

[ invert | x1 7 || cHitcH2 v

Horizontal

Timebase 1ms o

Samplerate | 1 MS/s v

Format T-Y hd

Calibration out | 1,0 kHz v

Trigger

Mode Auto v

Source | CH1 v

Slope 2~ || Normal v

Spectrum

[[]sP1 20 dB v
Markers Time:-1,00 ms .. , A\:2,00 ms (300 Hz) [Jsp2 20 dB v

[Jspm  |2048 v

CH1 C 2,00 Vidiv 4,00 Vpp 1,16 Vims 0 =

<>

Frequencybase| 1 kHz

OpenHantek with default Linux theme ,Breeze”

This demo mode provides a sawtooth and a square voltage. You can play with gain, timebase
and trigger settings, check out the spectrum of the signals or export the data as *.csv, *.json,
* pdf or *.png file.
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Quick Start Guide

Use one of the two supplied probes and connect it to
CH1.

Switch the red slider on the probe into the 1X position.
Connect the hook of the probe tip to the left calibration out connector.

Connect the alligator clamp of the probe to the right calibration out connector.

The scope will show a yellow square wave trace.

If the trace isn't stable drag the small yellow arrow on the right of the trace a
little bit up, so that it is positioned in the middle of the trace.

The trace will snap into position and the top left red - will turn into green TR.

Play a little with the settings to gain experience.
Detailed descriptions of all features can be found on the following pages.

OpenHanteke022 (20210622 - commit 915) - Device DSO-6022BE (FW0209)
View Oscilloscope Help
Voltage

10 kS on screen 1 M3/s 1 msldiv

7~

L

Ay

Q ........ -_— ACH‘AC .
A : : : :

Timebase 1ms -

Samplerate |1 MS/s -

Format T-Y b

Calibration out| 1.0 kHz v
Trigger =]

R S o .

Source | CH1 v

................................................ Slope |2~ ~ |HF -
Spectrum =

SP1 60 dB -

sP2 60 dB M

2,02 Vpp 980 m! 15 - 00 kHz SPM 80 dB -

Frequencybase| 1 kHz =

OpenHantek with Linux theme ,Fusion” that gives a more compact screen
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Measuring

The OpenHantek6022 program resembles the typical view of a real hardware oscilloscope, so
anyone who has experience with scopes (including analog CRT devices) should be able to
operate it.

Those who lack this experience should keep in mind that a scope is a complex measuring
instrument, so a basic understanding of how it works is required to perform correct
measurements.

The program version, device type and firmware version are displayed in the top line of the
window (marked green). This information is mandatory when reporting issues.

OpenHantek6022 (20210622 - commit 915) - Device DSO-6022BE (FW0209)

File  Export  View  Oscilloscope  Help
210,0ms 10,0 ) kS eel 0 kSi/s 10 ms/div 30 Hz/div SRElENES
CH1 500V v
[J wnvert | xto0 || DC v

CH2 | 200 mV v

) ~

] nvert | x1 DC w

] maTH | 2v v

~

[ ] invert | x1 CH1AC v

O Q

Haorizontal

Timebase 10ms

<>

Samplerate 10 kS/s
Format T-¥ hd

Calibration out | 1,0 kHz hd

Trigger
Mode Auto v
Source CH1 v
Slope A ~ || Normal v
Spectrum
SP1 60 dB hd
SP2 60 dB b
mE 80 ¢B v

<>

Frequencybase | 50 Hz

The scope functions can be controlled by the four docks (marked orange) on the right:
Voltage, Horizontal, Trigger and Spectrum. These docks can be floated, rearranged or tabbed
by grabbing their title lines, dragging and dropping. Drop on the screen to float it or move it
over the docking area and drop it either on an empty blue space to rearrange it or drop it on
another blue dock to tab both together. This way you can reduce the needed screen height
when used on older computers or laptops.

The selected settings are automatically saved when you exit and restored the next time you
start the program.

The bottom line shows settings and results of measurement and calculation, see the
explanation in the last paragraph on the next page.

300 Vidiv 50,0 dB/d \ T 240 Vrms
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Voltage
Both channels measure the voltage related to GND.
GND is directly connected also to the PC and to the
CH1 |1V . main's GND so never ever connect GND of the scope to
other voltages as it can destroy the scope and the PC!
This is not a limitation of this device but typical for most
(N cHz | 200mv . scopes, even for much more expensive ones.
Each channel can be selected or deselected by ticking CH1
L] iwert | x1 - “ | or CH2. Input signal polarity can be Inverted.
(] MATH | 2V . AC/DC coupling can be selected if the scope's HW supports
this feature (—» Help menu entry AC Modification).
[ mvert [ x1 - TUCHIAC 1 The vertical position of the trace can be changed by
dragging the name label left of the trace.
The default colors of the traces CH1 and CH2 correspond to the channel colors
yellow and blue on the front of the scope hardware.
The maximum measurable input signal range is -5V ... +5V, values outside this
range are clipped (shown as minimum or maximum value).
Input voltages outside the safe range of +35 V can lead to permanent damage!
Input sensitivity per division can be selected from 20 mV/div up to 5 V/div (1/2/5 steps) by the
control field. Each channel has an amplifier with selectable gain that allows the amplification
of the input signal by the factor 1X (5 V/div, 2 V/div, 1 V/div), 2X (500 mV/div), 5X (200 mV/div)
or 10X (100 mV/div, 50 mV/div, 20 mV/div), the available input voltage range decreases
accordingly from 5V to 2.5V, +1 V and +500 mV.
The display's height is 8 div, marked with horizontal dotted lines on the screen.
The two supplied Hantek probes allow a signal attenuation of 1/10, so the possible
maximum input voltage range is increased ten times to £50 V (e.g. 12 V input will be
measured by the scope as 1.2 V). The probe attenuation box eases the usage of this x10
range by multiplying the displayed value by 10 (the measured example value of 1.2 V from
above will be displayed correctly as 12 V). To support a variety of different probes, you can
type in any attenuation factor 1..1000 or simply scroll up/down.

\oltage

[ ] invert | x1 DC w

The scope also calculates typical values of each active channel and displays them in the
colored bottom lines, the values from left to right are:

Channel name, AC/DC coupling or math mode, voltage range, spectrum range, peak-to-peak
voltage (Vpp), DC voltage component, AC voltage component, true RMS voltage ( i.e. sqrt( DC?
+ AC?)), RMS displayed as dB - either dBV (0 dBV = 1 V rms), dBu (0dBu = TmW @ 600 Q) or
dBm (0dBm =1 mW @ 50 Q), power dissipation on a defined load (optional, load resistance
can be set in Oscilloscope/Settings/Analysis), the THD of the signal (optional), the musical
note value (optional) and finally the signal frequency.

A red channel marking (e.g. -) warns when the input signal exceeds the channel's physical
input range and clipping has occurred.
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MATH Channel operations

The MATH channel (purple color) allows simple calculations with the measured signals from
both physical channels CH1 and CH2, displays the result and can serve as a trigger source:

* Arithmetical binary operations: CH1+CH2, CH1-CH2, CH2-CH1, CH1*CH2
The subtract functions allow the measurement of voltages between two points in a
circuit by measuring both with CH1 and CH2 and subtracting the values.
Math mode CH1*CH2 can be used to calculate the momentary power as product of
voltage and current (when current is measured with a 1 Q shunt in the GND line then
1 VZin MATH display equates a power of 1 W). Or you can use a current probe and
scale accordingly.

* Logical binary operations: CH1&CH2, /CH1&/CH2, /CH1&CH2, CH1&/CH2, CH1=CH2
Use the logical condition of the input channels CH1 and CH2 (false if below the
channel-related trigger level, otherwise true) and combines both conditions, providing
false =0 and true = 1.

* Comparison operations: CH1 > CH2, CH1 < CH2
Compare the Voltage of both channels, providing false = 0 and true = 1.

If you trigger on the MATH channel, it allows you to define more complex trigger
conditions such as "CH1 <3V & CH2 > 5V".

* Arithmetical unary operations: CH1%, CH2?, CH1 AC, CH2 AC, CH1 DC, CH2 DC,
CH1 Abs, CH2 Abs, CH1 Sign, CH2 Sign, CH1 AC Sign, CH2 AC Sign
The square operations can be used to show the momentary power of a signal.
The AC modes calculate the AC component of a channel by averaging over the
sampled signal and subtracting this value from the samples, leaving only AC.
The DC modes show just this averaged value, Abs calculates the absolute signal value
while Sign gives +1 for positive values and -1 for negative values.

* Unary filter operations: CH1 LP10, CH2 LP10, CH1 LP100, CH2 LP100
Zero-phase (non-causal) bidirectional low-pass filtering with t= 10 or t= 100 based

on 10000 samples on the screen.

* Logical unary operations: CH1 trigger, CH2 trigger
Deliver 0 when below trigger level and 1 otherwise.
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Offset and Gain Calibration
The scope has a quite big zero point error - also the gain is defined by resistors with 5%

tolerance in the frontend.
To reduce this effect OpenHantek uses individual correction values:
1. Offset and calibration read from EEPROM.

2. Offset and gain calibration are read from a calibration file:
DSO-6022BE_NNNNNNNNNNNN_calibration.ini, stored at
~/ .config/0OpenHantek/ (Linux, Unix, macOS), or
%APPDATA%\OpenHantek\ (Windows).

To calibrate the offset, just do the following: lioscope g

1. Short circuit both inputs, e.g. with a 50Q termination plug o Sekings.

or by shorting the probe inputs. [ Caiibrate Offset L}

2. Enable menu setting Oscilloscope/Calibrate Offset. I (# Manual command I

3. Slowly select all voltage settings for CH1 and CH2 (set a slow sample rate of e.g. 10 ms/div).
4. Disable menu setting Oscilloscope/Calibrate Offset.

For safety reasons, calibration will not be carried out if the input signals are too noisy or have
a too big offset. If successful, the calibration values are stored in the EEPROM when the
oscilloscope is switched off. The next time the oscilloscope is started, the calibration is read
and used until the next change.

If you also want to adjust the gain, simply edit the calibration file and change the gain values
from 1.0 to the desired value (a value > 1 increases the amplitude, a value < 1 decreases it).
Step 1 above uses the factory offset calibration values in EEPROM. Out of the box only offset

values are contained in EEPROM.

Python Tool calibrate_6022.py

To create also gain calibration in EEPROM, either edit the ini file by hand or use the program
calibrate_6022.py from package Hantek6022AP]I, installed in /usr/bin.
(https://github.com/Ho-Ro/Hantek6022API)

This program allows to update these values in case the offset or gain has changed over time:
1. Measure offset at low and high speed for the four gain steps x10, x5, x2, x1.

2. Measure gain for the four gain steps x10, x5, x2, x1.

3. Write offset values into ini file or EEPROM.
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Horizontal
The displayed time range of the trace can be selected by
Timebase between 10 ns/divand 100 ms/div in 1/2/5 steps.

Harizontal

Timebase 1ms Z  Thedisplay's width is 10 div, marked with vertical dotted lines
Samplerate 1 MS/s o on the s.creen. . )

The optimal Samplerate will be selected automatically but the
Format user can also change this manually within the realistic range.
Calibration out| 1,0 kHz ¥ The maximum sample rate is 15 MS/s when sampling two

channels.
If only CH1 is used, the maximum sample rate doubles to 30 MS/s.
The effective sample size used for display, calculations and export is always 20 kS. For
(effective) sample rates lower or equal 10 MS/s a 2 to 200 times oversampling is used to
decrease the noise floor by up to 10..20 dB. This increase the effective resolution of the 8-bit
ADC to almost 10..12 bit at low speed operation.
(Each 4X oversampling adds one bit, 4X = 9 bit, 16X—10 bit, 64X—11 bit, 256x - 12 bit...).
-~ https://www.silabs.com/documents/public/application-notes/an118.pdf
To gete.g. 20 kS @ 1 MS/s the scope samples 200 kS
@ 10 MS/s and averages over 10 samples each. An

overview of all sample settings is also visible top right
of the trace window. _

Format selects T-Y (i.e. normal scope display, voltage (Y) over time (X))

or X-Y (CH1 =X, CH2 =Y), the horizontal position on the screen can be changed by dragging
the trigger marker on the top, the vertical position on the screen can be changed by
dragging channel CH2 left of the traces window.

Calibration out selects the frequency of the calibration output (a 2 Vpp square wave) on the
right of the scope, set to 1 kHz at each program start. The frequency can be selected
between 32 Hz .. 100 kHz in small steps. This can be used as a simple signal generator. The
output signal is created by software, so at high frequencies a phase jitter may occur (x250ns).

A HW modification allows to create a jitter-free signal, documentation is available on GitHub:
HANTEK6022 Frequency Generator Modification.pdf

Two Markers (vertical lines, marked with 1 and 2) allow to measure time as well as frequency
of the traces by dragging the lines. New markers can be positioned also by click and drag
inside the trace window. <Double click> creates two markers with a distance of 10% of the
screen width, allowing a 10x zoom. <Control> decreases the distance to 1% - 100x zoom,
<Shift> centers the markers around the trigger position. Both modifiers can be combined.
<Right double click> moves the markers out of the way to the left and right screen margins.
<Scroll wheel> moves both markers left/right, <Ctrl scroll wheel> changes their distance.

1 2

10 kS on screen 1 MSs 10x ovr 1 maidiv

Markers Time: 3.000 ms -> 4,000 ms, At 1.000 ms (1.000 kHz) Frequency: 4.000 kHz -> 4.500 kHz, Af: 500.0 Hz

3
Q
A

- The digital Phosphor function (sine waves icon) simulates a slow fade out of
traces to detect short events (shortcut <P>).

- The Histogram (gaussian bell icon) shows the probability density function of the
signal voltage at the right to identify hidden structures of the signal. (<H>).

- The Zoom function (magnifying glass icon) displays a new window below the
main window with zoomed time range equating the markers distance (<Z>).

- The Measure function (drafting compass icon) opens an extra section and allows
measurement of time or frequency span and levels (<M>).
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Trigger

Triggering allows to display a stationary trace by fixing a

rising or falling Slope of the signal of the selected Source

Mode | Auto v channel to a defined position on the screen. The
triggering is done in software by searching for the trigger
condition in the sampled values and skipping the

Slope A  ~| HF v necessary amount of leading samples to position the trace
accordingly.

Trigger

Source CH1 o

Trigger Mode can be:
+ Auto - display a free-running trace even if no trigger point is detected.
+ Normal - display no trace without active trigger, hold the last triggered trace.
+ Single - display a new triggered trace every time the space bar (or key <S>) is pressed.
* Roll - display an untriggered free scrolling trace (available for timebase >= 200ms/div).
The display is updated permanently in real-time.

The play/pause icon O O (top left) starts and stops the display during Auto and Normal mode.
The keyboard shortcuts <Spacebar> or <Pause> or the key <S> also work as Start / Stop.

If the <Spacebar> does not work under Windows, you should use the other alternatives.
The refresh icon ,"_’,'.' (key <R>) clears the screen and starts a new trace in roll mode.

Trigger Source can be CH1, CH2 or MATH

Trigger Slope:
. Triggers on rising slope
. Triggers on falling slope

* X% Triggers alternatively on rising and falling slope
Trigger setting can be HF (trigger even on fast spikes or glitches), Normal or LF (trigger on
stable slope only, ignore spikes).

The trigger level (voltage) can be selected by dragging the small
colored (e.g. yellow) arrow to the right of the recording window.
The trigger position on the screen can be selected by dragging the
colored (e.g. yellow) arrow at the top of the window.

),00 kS

Trigger status (TR = triggered, . = not triggered), source, slope, voltage level and horizontal
position are displayed in the upper left corner of the trace window followed by the pulse
width of the triggered pulse and the following pulse in opposite direction and the duty cycle.

Trigger Slope %:

Triggers on alternating slopes.
Can be used together with
digital phosphor to show a
kind of eye diagram, either
triggered on the signal itself
or by a stable trigger signal

on the other scope channel.

5,000 MS/s 2,000 ps/div 500,0 Hz/div
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Spectrum

Spectrum «  The program calculates the voltage spectrum of the three
channels using the discrete FFT and displays the results if
SP1 60 dB e
enabled.
sP2 6008 ¥ The displayed values are shown as dBV (0 dBV equals 1V rms)
(] sPm 80 dB v or based on another reference level, see below.

The Frequencybase setting selects the resolution of the
spectrum in Hz/div.

<2

Frequencybase| 50 Hz

The applied Window function as well as the reference level for the spectrum calculation can
be changed in the menu: Oscilloscope / Settings / Analysis

Settings

Set Reference Level

0 dBv

0 dBu =-2.2dBV (1 mW @ 600 Q) -13,0

<

dBY

0 dBm =-13 dBV (1 mW @ 50 Q)

Spectrum

Window function Flat top L
m Minimum magnitude -80.0 dBm

|:| Optimize FFT (slower startup, but lower CPU load)
Colors

<>

Analysis

£
o]

I Calculate power dissipation for load resistance 50

|:| Calculate total harmonic distortion (THD)

|:| Show note values for audio frequencies

The default Reference Level can be set with the tree buttons on the left or by typing a value
on the right. This doesn't change the input impedance, if you want to measure loaded
signals, a capable dummy load must be connected to the scope input.

-0 dBV converts a 1 V rms sinusoidal signal into a displayed 0 dB amplitude frequency peak.
- Professional audio measurements typically use dBu (aka. dBm @ 600 Q load):

0 dBu =0.775 V rms which corresponds to a reference level of -2.2 dBV.

- Conversely, RF uses typically a 50 Q load, 0 dBm equates approximately 0.224 volts:

0 dBm = 0.224 V rms which corresponds to a reference level of -13 dBV.

Typical Window functions are Hann (raised cosine), Gauss or Flat top. The Hann window has
the best frequency selectivity (narrowest bandwidth) while the Flat top window allows
accurate amplitude measurements. Gauss window characteristic is in between.

The Flat top window is typically employed on data where frequency peaks are distinct and
well separated from each other (e.g. for harmonic distortion measurements).

If the frequency peaks are not guaranteed to be well separated, the Hann window is
preferred because it is less likely to cause individual peaks to be lost in the spectrum.

Other different window functions are available for the curious user.

The frequency range of the spectrum can be selected in the Horizontal section, minimum
frequency is always zero, the maximum frequency is limited to the Nyquist frequency, this is
half the sampling rate.

A lower sampling rate yields a narrower frequency lobe and increases the selectivity while a
higher sampling rate allows to display a wider frequency range at the cost of less selectivity.
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Important: Sampling a signal with spectral components above the Nyquist frequency leads
to aliasing, i.e. the higher spectral components are mirrored into the low frequency range.
This is not a limitation of this device, but should be considered when looking at the spectrum.

The Minimum magnitude setting hides the noise floor and calms the display;
all spectral components below this level are not displayed.

The Power setting allows to define a (dummy) load resistance of 1..1000 Q for which the
power dissipation of the measured voltages is determined ( R = 0 disables the calculation).

Also the THD of the signal can be shown optionally (only useful for harmonic signals).
Calculation: THD = sqrt( power of all harmonics / power of fundamental )

It is also possible to detect the musical note value of tones, this function can be used e.qg. to
tune your electrical guitar.
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Zoom Function

The zoom function (magnifying glass icon, shortcut key <Z>) opens a second

window below the main window with an enlarged time range corresponding to
the distance between the markers (1 & 2).

New markers can be positioned by click and drag inside the (un-zoomed) trace window.

A <double click> (left) creates two markers close to each other with a distance of 10% of the
screen width, thus defining a zoom rate of 10, <ctrl double click> defines zoom = 100.

The shift modifier centres the markers around the trigger point.
The <scroll wheel> moves both markers left / right, <shift scroll wheel> moves the markers

left / right with smaller steps (one step moves the zoomed content 10% of the screen width),
<ctrl scroll wheel> changes their distance (up to zoom 500x).

File Export View Oscilloscope

BB cH1 ~ 900 mv 50%

02V

Zoom x10: -200,0 ps 300,0 ps

Help

OpenHantek&022 (v2.13) - Device DSO-6022BE (FW0202)

20,00 ks

500,0 ps

1,417 V rms
26,81V rms

200,0 kS/s

Invert
V| CH2

Invert

MATH

Invert

Horizontal
Timebase

Samplerate

2,000 kHz 50,0.ps/div 100,0 Hz/div

Format

Trigger
Mode
Source

Slope
Spectrum
V| CH1

V| CH2

0,111 dB

1,000 kHz

5,430 kHz MATL

Frequencybase |1 kHz

Calibration out |1 kHz

@ X
2V =
X10 probe
50V =
V| X10 probe
5V b
CH1 AC =
& (%)
500 ps -
200 kS/s |+
T-Y =
@ X
Auto =
CH1 -
A =
= (%)
60 dB =
60 dB =
60 dB -

Mouse wheel scroll in the black border around the traces area changes the ratio of main to
zoom window height between 1:1, 2:1, 4:1, 8:1 and 16:1.

OpenHantek6022 User Manual
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Cursor Measurements

The measurement function (drafting compass icon, shortcut <M>) allows to
measure voltage or spectral amplitude as well as time or frequency intervals of
‘ one or more displayed tracks.

Select the trace (e.g. SP1), set it to ON (clicking on the ON/OFF text toggles its state) and draw
a (yellow) rectangle (red circle) to measure e.g. frequency and magnitude difference.

You can also draw another (blue) rectangle (purple circle) to measure a different trace.

OpenHantek&022 (v2.13) - Device DSO-6022BE (FW0202)

File
> G cH1 » 900 mv 50% 2000ks  200,0kS/s 500,0 ps/div 1,000 kHz/div R e@®
JIcH1 |2V =
;\f 200,0 Hz Invert X10 probe
Q v| CH2 50V hod
A Invert |v|X10 probe
MATH |5V -
Invert |CH1AC =
Horizontal =]
Timebase 500ps |5
Samplerate 200 kS/s |5
Frequencybase |1 kHz -
Format T-Y b

Calibration out |1 kHz =

Right Mouse Button Measurement

A quick measurement is possible at any
time with the right mouse button, it shows
the time and/or frequency at the cursor
position, as well as the measured value if
the cursor is within or near some traces.

OpenHantek6022 User Manual

Trigger @
Mode Auto v
Source CH1 =
Slope b =
Spectrum B
5l V| CH1 10 de -
5,000 ms 200,0 Hz V| CH2 60 dB -
MN7Vrms 1,017V dB1,000 kHz MATH |60d8 .

BTV Ims3784 my =

16/22

3,6 dB5,430 kHz
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Data Export
IE view Osciloscope The Export CSV function allows to store the measured samples and

(3 Screenshot the resulting spectral values as a *.csv file (comma separated
[ Hardcopy values). All 20000 voltage samples as well as all 10001 calculated
) Screenshot spectral components of all active channels are stored.
[ Hardcopy .. The values are stored as "t / s";"CHL / V";"f / Hz";"SP1 / dB"
3} i . . 0;8,0312242;0;-80
&= Print screen . SI basic units: 1e-06;0,0267636;50;-69,7756
. 2e-06;0,0312242;100;-70,2287

[3) Export CSV .. seconds, volts, hertz and dB. 36-06.0 0356848, 150,80
@ EKDDI’T JSON . 4e-06;0,0178424;200;-65,2348

= The field separator, usually a Se-06;0,022303;250;-63,2646

comma, is automatically changed to a semicolon for countries where the comma is used as
the decimal separator, e.g. Germany.
Export JSON stores the samples in JSON format with the same SI basic units as above.

Screenshot
The Screenshot .. function captures the program

window as a *.png picture (*.jpg is also possible) or a
* pdf file.

Screenshot stores as <DATE>_<TIME>.png without
asking.

Hardcopy IR CH1 7 0000V 50% 7496 55304 ps7 (50%)  10KS on screen NS Imsidv 1 kHoidiv
The Hardcopy .. function creates an image/pdf of the scope !

screen in printer colors that are optimized for print on paper;
Hardcopy stores as <DATE>_<TIME>.png without asking.

® » 10kS on screen. 1Ms/s. 1 ms/div 1 kHz/div I
1 1 a

A zoomed screen with 1:1

Zoomx5 t:-1,00ms.. 1,00 ms, At:200 ms (500 Hz) 200 psidiv

ratio of Zoom:main can be

77 _scaled to double height, (R ‘ :

configuration:

O Oscilloscope/Settings/Scope

'SREEETEEEEN
o2 i iiie

The Print .. function sends the hardcopy screen content to the

400Vpp 117Vms 20V 107V 13308 1,000kH:z

printer in pdf format, [HZ X 20V 200pp 141Vms 100V 100mV- Q00368 000K

On a HiDPI screen setup with upscaled applications it could be necessary to scale also the
exported images of screenshot, hardcopy or print to avoid missing trace details. The scaling
factor can be set in menu Oscilloscope/Settings/Scope — Upscale exported images
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Settings
The program behaviour can be chosen in

Oscilloscope / Settings / Scope menu:

Horizontal Mg -

If you want to measure very slow signals — o

the slowest possible timebase can be m Zoum

increased up to 10 s/div (this shows 100 s e

on the screen). | :

Be patient, in AUTO or NORMAL mode the e s
scope will not refresh the trace on screen St ettt e

V| Scope has hardware modification for AC coupling (restart needed to apply the change)

unless a full block is captured (and
triggered for NORMAL), but in ROLL mode
the screen is updated permanently.
Longer hold-off time between captured frames allows to lower the CPU load, while faster
sampling improves the triggering on rare events.

oK Apply Cancel

Graph

Digital phosphor depth defines the numbers of fading previous traces on the screen.

Interpolation mode can be either Off, Linear, Step or Sinc :

- Off displays only the real sampled points, difficult to detect with fast time base.

- Linear connects these points by straight lines, showing a continuous time curve.

- Step connects the points by steps, making it easier to see the real sampled values.

- Sinc interpolates with a bandlimited rounded curve if too few values are on screen, else
linear. It uses the simple heuristic: 'displayed values' < 'screen width in pixels'.

Zoom

Zoom area height factor defines the ratio between normal and zoomed screen.

Export 1:1 zoomed screen in double height is applied to exported hardcopy images as shown
on the next page.

Upscale exported images scales the screenshot/hardcopy/print images, useful to avoid
missing trace details on HiDPI screens with upscaled applications.

Configuration

The scope settings are automatically saved between sessions - for each unit individually
based on the serial number. Automatic Save settings on exit can be deactivated, to always
start with a predefined setup, e.g. set by Save settings now.

It is also possible to discard all user settings and Apply default settings after next restart.

The program shows tooltips for most user interface elements, useful for beginners, you can
disable them if you're experienced.

If you have modified the HW of the scope to support AC coupling (see detailed info in
the Help menu), tick the box here to use this function after the next restart.
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Appearance

OpenHantek6022 provides translations for Chinese, French, German, Italian, Polish,
Portuguese, Russian and Spanish and Swedish. The Chinese, French, German, Polish,
Russian, Spanish and Swedish translations are complete, the other languages are almost
complete. The translations were provided and checked by native speakers. Volunteers for
other languages are welcome!

OpenHantek6022 automatically adapts to the used light or dark system or user theme.

* OpenHantek6022 (3.0.1) - Device DSO-6022BE (FW0204)

Datei Exportieren Ansicht Oszilloskop  Hilfe

> B o » 500 2 eig M/ 200 ps/div 2,5 krzvdiv [ o

VI cHL sv =
Ay Invertiert [ |X10 |DC ~
A

DU VU TUULUUUUUUUUUULUUUUU U L e

v MATH

Samplerate

Frequenzb:

Modus

Quelle

Flanke

Spekirum
v CH1 100 dB
v CH2 100 dB

v MATH |100dB

The colors of the traces on the screen 18 S
as well as the exported png / pdf UL S ek - .
documents can be adjusted Soope i i =
; o L om T
individually in the menu VLI
. . Border i #7000000
Oscilloscope / Settings / Colors. Anaysis N —
Text H #f000000
You can also select Fusion style o s ot e
H cH1 #mmoo | [ smeooo | (RIILT
instead of the system theme style, o —
active after next restart. Especially on e omoor | _smotea | _smoor | _smotes
Linux systems Fusion gives ad more | Export hardeopy images o pdf files with printer colors
V| Fusion style (restart needed io apply the change)
Com aCt WIndOW that fItS erfectl On Theme (restart needed to apply the change) Auto
y
sma”er screens, e.g. HD1 280X720 Of Font size (reslart needed to apply the change) 10 =
older Laptops. & oot e

It is possible to select an Auto (=System), Light or Dark Theme, active after next restart.

Font size can be set from 6 to 24 point after next restart (default = 10). This setting allows to
scale the text and widgets to adapt for different screen sizes and dpi values.
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Command Line Options
OpenHantek6022 offers these command line options:

Usage: ./OpenHantek [options]

Options:
-h, --help Displays help on commandline options.
--help-all Displays help including Qt specific options.
-v, --version Displays version information.
-c, --config <File> Load config file
-d, --demoMode Demo mode without scope HW
--noAutoConnect Do not connect automatically
-e, --useGLES Use OpenGL ES instead of OpenGL
--useGLSL120 Force OpenGL SL version 1.20
--useGLSL150 Force OpenGL SL version 1.50
-i, --international Show the international interface, do not translate
-f, --font <Font> Define the system font
-s, --size <Size> Set the font size (default = 10, ©: automatic from
dpi)
--condensed <Condensed> Set the font condensed value (default = 87)
--resetSettings Reset persistent settings, start with default
--verbose <Level> Verbose tracing of program startup, ui and

processing steps

The -use... options allow to force a different OpenGL version than the automatically detected
(e.g. in case of display artifacts).

The font setting options allow to adapt the appearance for very small and very big screens,
the widgets will be scaled accordingly. The font size is also available from the settings menu.

The verbose setting allows to trace the program startup/shutdow, the user interaction, and the
processing with increasing details, output goes to stderr: 0: quiet; 1,2: startup and shutdown;
3,4: +user interaction; 5,6: +data processing (lot of output!); 7: +USB communication;

Tips and Tricks for the Experienced User

Under Linux the program tries to get a higher real-time priority to yield a slightly better USB
allocation, especially at high sampling rates (30 MS/s for one channel, 15MS/s for two
channels). To make this possible, the user must be a member of a real-time group. This
could be e.g. the group audio, if you are performing professional audio processing with JACK.
1. set limits in /etc/security/limits.d:
@audio - rtprio 90

2. add user to the group, e.g. audio:
usermod -a -G audio <your_user_name>

But you can also set the limits for your user only:
1. set limits in /etc/security/limits.d:
<your_user_name> - rtprio 90

These settings work best when you're using a realtime-kernel, e.g. the debian package linux-
image-rt-amd64. But also the recent standard kernels allow to set higher priority and better
scheduling if enabled for your user.
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Hantek6022 Analog Front End (One Channel)

2 i 47 = BAV99 Hantek 60228E

Front End

AD9288

<+ or - 0.5V (500mV)

R20

“out W -
% L
® +5Y
L ‘- —— 5 i 2
= Eg ty 1! 15 x1 Vin <50V
3 > § 2 I?svi ADS268 max 1,024  p-p input
Vin=<5V o ‘
Sy quivalent Analog Circuit
R18 = =
& Lx2 vin <2.5V
X100 probe has no switch 5V 1k
3rd row refers. —
5V e
Probe <5V on x1, V x 1=<5V )4 R19
<50V on x10; V x0 . 1=<5V o 4 AAA x5 Vin <1.0V
<500V on x100; V x 0.01=<5V ¥ 4k1 =
CHANNEL I0A4 [} 1 ~ 18 i 5| N
Vin must always be less CHANNEL I/ 5| 5V
than 5V, otherwise clipping 14[] CHANNEL 10 A1 12 R22 .
will be applied el x10 Vin <0.5V
7 =d. 9k1
m—
k g sv 7
: 74HC4051
Va = Vi Vout = Ve(1+ RIMKOhm
Ve = Vin/10 Analog MUX ( )

The input signal Vi, is divided 1:10 by a frequency compensated resistors R27/17 and R31/21.
Clamping diode A7 limits V. to +5 V (equates Vin = £50 V). U11/7 together with the analog
multiplexer amplifies V. by 1X, 2X, 5X or 10X (Vout).

which is contrary to the data sheet requirement for the ol O

common mode voltage:

Vou is fed into the ADC AD9288 that measures the FUNCTIONAL BLOCK DIAGRAM
difference between A, and /A, and converts the =
difference input voltage range -512 mV .. +512 mV ENC, O St g
into digital values 0x00 .. OXFF (0 V equates 0x80). :_:: mS> < avc | E O 07,-00,
Unfortunately Hantek decided to operate the ADC far ~ serua) 5] =
. REF gy () (}SELECT 2
out of spec with a common mode voltage V. =0V, REF )8 () [E]  Soameomu
:
E
3]

Ve=03xV,-02V..03xV;+0.2YV,
withVs=3V->V.=27V.3.1V

&
o
4
=]
=

g

(L. R

Probably due to this misdesign the first 1000..1500 samples of a measured block are
unstable, OpenHantek6022 bypasses this behavior by sampling more values and dropping
the first ~2000.

Input AC Coupling

Another bad design decision by Hantek was that the oscilloscope does not support AC
coupling of input signals - but you can modify the hardware yourself.
A short AC modification howto is available via the Help menu or from github:

HANTEK6022_AC_Modification.pdf
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https://github.com/OpenHantek/OpenHantek6022/blob/main/docs/HANTEK6022_AC_Modification.pdf

Hantek6022 Digital Back End

CY7C68013A-100
2x%4051 Mux
4xAD8065 Op Amp AD9288

o L 1 3 PC2..4 (PAL.3) use
1 H | Power
| Lo i Commiy < vee
iz |1 ! DMINUS D-
CH1 3] - DA | 8 FDO..7 = PBO..7 DPLUS bs
X X
] 1 1 c I
l : b e ; IFCLK ne
| 1 | | GND
! o : [
| b ; CTL2 (CTLO) -
| Lo encs [
1 1
CHz 5 — o8 |- 8 FDS..15 = PDO..7
| |
Loso.2 |i i Vee
= ! | |
| | L } 3 PCS..7 (PA4..6) ﬁ
Lo DFS Ly
! E (s« n/a PA7 onlyBL
! ! S115 Vee SDA SDA Vs |
__GAIN_ 1y ADC 2 scL scL e
Calibration ) — <| PA7 (PC2) | we ALl
out AA Vee A0 |—
1 PC1
G
L1 reen - vee  24LC02B
P
{>| red & EEPROM
Ny

L

24 MHz

The Hantek6022 (BE & BL) backend is built around the EzUSB processor CY7C68013A that
handles USB communication, ADC timing, front-end channel gain setting and also generates
the calibration output signal. Hantek 6022BE and 6022BL (in scope mode) differ slightly in the
use of the processor pins (different BL pins in green), but otherwise work identically.

Firmware Storage

EzUSB does not store the user firmware permanently in flash memory, it must be uploaded

to RAM each time the unit is turned on. The program OpenHantek6022 checks if the correct
firmware version is loaded. In case it detects no FW or a wrong FW version (e.g. because of

using the scope with sigrok or the original Hantek software before) the correct firmware will
be uploaded automatically. If no device is detected, disconnect / reconnect the USB plug.
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	Scope Inputs
	Voltage Limits

	Calibration Output
	USB Connection
	OpenHantek6022

	Starting OpenHantek6022
	Other Operating Systems
	FreeBSD
	MacOS
	Raspberry Pi
	Windows
	MINGW
	MSVC


	Demo Mode
	Quick Start Guide
	Use one of the two supplied probes and connect it to CH1.
	Switch the red slider on the probe into the 1X position.
	Connect the hook of the probe tip to the left calibration out connector.
	Connect the alligator clamp of the probe to the right calibration out connector.
	The scope will show a yellow square wave trace.
	If the trace isn't stable drag the small yellow arrow on the right of the trace a little bit up, so that it is positioned in the middle of the trace.
	The trace will snap into position and the top left red TR will turn into green TR .
	Play a little with the settings to gain experience. Detailed descriptions of all features can be found on the following pages.
	OpenHantek with Linux theme „Fusion“ that gives a more compact screen
	Measuring
	Voltage
	MATH Channel operations

	Offset and Gain Calibration
	Python Tool calibrate_6022.py

	Horizontal
	Trigger
	Spectrum
	Zoom Function

	The zoom function (magnifying glass icon, shortcut key <Z>) opens a second window below the main window with an enlarged time range corresponding to the distance between the markers (1 & 2). New markers can be positioned by click and drag inside the (un-zoomed) trace window.
	A <double click> (left) creates two markers close to each other with a distance of 10% of the screen width, thus defining a zoom rate of 10, <ctrl double click> defines zoom = 100.
	The shift modifier centres the markers around the trigger point.
	The <scroll wheel> moves both markers left / right, <shift scroll wheel> moves the markers left / right with smaller steps (one step moves the zoomed content 10% of the screen width), <ctrl scroll wheel> changes their distance (up to zoom 500x).
	Mouse wheel scroll in the black border around the traces area changes the ratio of main to zoom window height between 1:1, 2:1, 4:1, 8:1 and 16:1.
	Cursor Measurements
	Right Mouse Button Measurement


	Data Export
	Screenshot
	Hardcopy
	Settings
	The program behaviour can be chosen in Oscilloscope / Settings / Scope menu:
	Horizontal If you want to measure very slow signals the slowest possible timebase can be increased up to 10 s/div (this shows 100 s on the screen). Be patient, in AUTO or NORMAL mode the scope will not refresh the trace on screen unless a full block is captured (and triggered for NORMAL), but in ROLL mode the screen is updated permanently. Longer hold-off time between captured frames allows to lower the CPU load, while faster sampling improves the triggering on rare events.
	Graph
	Digital phosphor depth defines the numbers of fading previous traces on the screen.
	Interpolation mode can be either Off, Linear, Step or Sinc : - Off displays only the real sampled points, difficult to detect with fast time base. - Linear connects these points by straight lines, showing a continuous time curve. - Step connects the points by steps, making it easier to see the real sampled values. - Sinc interpolates with a bandlimited rounded curve if too few values are on screen, else linear. It uses the simple heuristic: 'displayed values' < 'screen width in pixels'.
	Zoom
	Zoom area height factor defines the ratio between normal and zoomed screen. Export 1:1 zoomed screen in double height is applied to exported hardcopy images as shown on the next page. Upscale exported images scales the screenshot/hardcopy/print images, useful to avoid missing trace details on HiDPI screens with upscaled applications.
	Configuration
	The scope settings are automatically saved between sessions - for each unit individually based on the serial number. Automatic Save settings on exit can be deactivated, to always start with a predefined setup, e.g. set by Save settings now.
	It is also possible to discard all user settings and Apply default settings after next restart.
	The program shows tooltips for most user interface elements, useful for beginners, you can disable them if you're experienced.

	If you have modified the HW of the scope to support AC coupling (see detailed info in the Help menu), tick the box here to use this function after the next restart.
	Appearance
	OpenHantek6022 provides translations for Chinese, French, German, Italian, Polish, Portuguese, Russian and Spanish and Swedish. The Chinese, French, German, Polish, Russian, Spanish and Swedish translations are complete, the other languages are almost complete. The translations were provided and checked by native speakers. Volunteers for other languages are welcome!
	OpenHantek6022 automatically adapts to the used light or dark system or user theme.
	The colors of the traces on the screen as well as the exported png / pdf documents can be adjusted individually in the menu Oscilloscope / Settings / Colors.
	You can also select Fusion style instead of the system theme style, active after next restart. Especially on Linux systems Fusion gives a more compact window that fits perfectly on smaller screens, e.g. HD1280x720 of older Laptops.
	It is possible to select an Auto (=System), Light or Dark Theme, active after next restart.
	Font size can be set from 6 to 24 point after next restart (default = 10). This setting allows to scale the text and widgets to adapt for different screen sizes and dpi values.

	Command Line Options
	Tips and Tricks for the Experienced User
	Under Linux the program tries to get a higher real-time priority to yield a slightly better USB allocation, especially at high sampling rates (30 MS/s for one channel, 15MS/s for two channels). To make this possible, the user must be a member of a real-time group. This could be e.g. the group audio, if you are performing professional audio processing with JACK.
	But you can also set the limits for your user only:
	Hantek6022 Analog Front End (One Channel)
	The input signal Vin is divided 1:10 by a frequency compensated resistors R27/17 and R31/21. Clamping diode A7 limits Ve to ±5 V (equates Vin = ±50 V). U11/7 together with the analog multiplexer amplifies Ve by 1X, 2X, 5X or 10X (Vout).
	Vout is fed into the ADC AD9288 that measures the difference between Ain and /Ain and converts the difference input voltage range -512 mV .. +512 mV into digital values 0x00 .. 0xFF (0 V equates 0x80).
	Unfortunately Hantek decided to operate the ADC far out of spec with a common mode voltage Vc = 0 V, which is contrary to the data sheet requirement for the common mode voltage:
	Vc = 0.3 x Vd – 0.2 V .. 0.3 x Vd + 0.2 V, with Vd = 3 V → Vc = 2.7 V .. 3.1 V
	Probably due to this misdesign the first 1000..1500 samples of a measured block are unstable, OpenHantek6022 bypasses this behavior by sampling more values and dropping the first ~2000.
	Input AC Coupling

	Another bad design decision by Hantek was that the oscilloscope does not support AC coupling of input signals – but you can modify the hardware yourself. A short AC modification howto is available via the Help menu or from github:
	Hantek6022 Digital Back End
	Firmware Storage


